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ABSTRAK 
 
 
 Bendung Klambu yang terletak di Grobogan, Jawa Tengah memiliki permasalahan pada 
penggal hulu bendung, terutama pada bagian belokan sungai karena terdapat deposisi sedimen di 
daerah dalam belokan. Deposisi sedimen terjadi karena terdapat perbedaan kecepatan pada daerah 
luar dan dalam belokan sungai. Pembuatan krib merupakan salah satu solusi dalam mengurangi 
deposisi sedimen pada dalam daerah sungai. Krib akan mengubah pola aliran dan distribusi 
kecepatan sehingga tren kecepatan pada daerah dalam belokan sungai akan meningkat. 
 Penelitian ini akan menganalisa pola aliran dan distribusi kecepatan aliran di belokan 
sungai sebelum dan setelah adanya krib dengan menggunakan aplikasi Telemac2D. Data yang 
diperlukan untuk melakukan penelitian yaitu peta topografi sungai, nilai debit aliran, serta kondisi 
batas sungai. Penelitian dilakukan menggunakan tiga varian panjang (30 m, 40 m, dan 50 m) serta 
dua jenis krib (permeabel dan impermeabel). 
 Kecepatan pada daerah dalam belokan sungai yaitu 0-0,185 m/s sedangkan pada daerah 
luar belokan sungai senilai 0,74-1,67 m/s. Distribusi kecepatan dalam belokan sungai menggunakan 
krib permeable dan impermeable 30 m yaitu 0-0,18 m/s, krib permeable 40 m yaitu 0,185-1,67 m/s, 
krib impermeable 40 m yaitu 0-1,67 m/s, dan krib permeabel atau impermeabel sepanjang 50 m 
yaitu 0,74-1,67 m/s. Pola aliran di daerah antar krib pada krib permeabel tidak teratur, sedangkan 
pada krib impermeabel terbentuk pusaran air. Pola aliran di dalam belokan sungai menggunakan 
krib 30 m dan 40 m pada kedua jenis krib menghasilkan pola aliran berbentuk pusaran air. Pusaran 
air pada daerah dalam belokan menjadi pola aliran yang searah dengan aliran sungai dengan 
menggunakan krib permeabel atau impermeabel sepanjang 50 m. 
 
Kata Kunci : Pola Aliran, Distribusi Kecepatan, Krib, Telemac2D 
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ABSTRACT 
 
 
 The upstream reach of Klambu Weir which located on Grobogan, Jawa Tengah has an 
issue because of sediment deposition that occurs on the river bend. Therefore, it is required to find 
the solution to remove the sediment deposition. Sediment deposition happens because of velocity 
difference on the inside and outside part of river bend. Groyne is one of many solution that can 
remove the sediment deposition on river bend. Groyne change flow pattern and velocity distribution 
so the velocity on the inside part of river bend equal to the outside part of river bend.  

This research will analyze the flow pattern and velocity distribution on river in normal 
condition and after the installation of groyne using an application called Telemac2D. For doing the 
simulation, some data is necessary including river topography, flow discharge, and river boundary 
condition. This simulation process will be done by using three length variation (30 m, 40 m, and 50 
m), also two type of groyne (permeable and impermeable). 
 From the result of this simulation, the velocity inside the river bend is 0-0,185 m/s, 
meanwhile on the outside part of river bend is 0,74-1,67 m/s. Velocity distribution on the inside part 
of river bend using 30 m permeable and impermeable is 0-0,18 m/s, using 40 m permeable groyne 
is 0,185-1,67 m/s, using 40 m impermeable groyne is 0-1,67 m/s, and using 50 m permeable and 
impermeable groyne is 0,74-1,67 m/s. Flow pattern between permeable groyne shows that there is 
irregular flow, meanwhile on between impermeable groyne an eddys formed. Flow pattern on the 
inside part of river bend using 30 m and 40 m groyne shows that an eddys formed with area less 
than the original condition, meanwhile using 50 m groyne shows that the flow pattern have the same 
direction with the river flow. 
 
Keywords : Flow Pattern, Velocity Distribution, Groyne, Telemac2D
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BAB I 
PENDAHULUAN 

 
 
 
1.1 Latar Belakang 

Bendung Klambu merupakan bendung yang mengairi daerah irigasi seluas 

43.000 hektare yang terletak di Kecamatan Klambu, Kabupaten Grobogan, Jawa 

Tengah. Bendung tersebut dibangun beberapa puluh tahun lalu yang kemudian 

dilakukan revitalisasi pada tahun 2017-2018. Revitalisasi Bendung Klambu 

bertujuan untuk menanggulangi banjir di Kabupaten Grobogan dan mengaliri 

sawah serta kebutuhan air masyarakat. Revitalisasi di hulu Bendung Klambu 

dilakukan karena kurangnya perawatan yang memadai sehingga tingkat kebocoran 

bendung semakin tinggi (RadarKudus, 2019).  

Kurangnya perawatan pada Bendung Klambu menyebabkan tingginya tingkat 

sedimentasi pada daerah hulu bendung. Deposisi sedimen paling tinggi terjadi pada 

daerah tikungan sungai di hulu bendung yang dapat dilihat pada Gambar 1.1.  

 

 
Gambar 1.1 Deposisi Sedimen Pada Hulu Bendung Klambu 

 (Sumber : Google Earth)  

1 
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Salah satu penyebab terjadinya deposisi sedimen pada belokan sungai yaitu 

terjadi kecepatan yang lebih tinggi pada daerah luar sungai daripada daerah dalam 

belokan sungai (Graf & Altinakar, 1998). Kecepatan dalam belokan sungai perlu 

ditingkatkan sehingga permasalahan deposisi sedimen dapat teratasi. Oleh karena 

itu, solusi diperlukan untuk mengubah tren kecepatan pada belokan sungai, salah 

satunya adalah dengan pembuatan krib. 

Krib akan mengubah arah pola aliran dan distribusi kecepatan pada daerah 

dalam dan luar belokan sungai. Analisis terhadap krib dalam mengubah pola aliran 

dan distribusi kecepatan perlu dilakukan dengan menggunakan beberapa jenis dan 

variasi krib untuk mengetahui variasi dan jenis krib paling terbaik. Oleh karena itu, 

dibutuhkan simulasi aliran menggunakan beberapa jenis dan variasi krib untuk 

mengetahui pola aliran dan distribusi kecepatan pada sungai. 
 

1.2 Rumusan Masalah 

Berikut rumusan masalah dalam penulisan Tugas Akhir. 

1. Bagaimana distribusi kecepatan pada sungai di ruas hulu Bendung Klambu 

sebelum dan setelah dibangunnya krib? 

2. Bagaimana arah pola aliran pada sungai di ruas hulu Bendung Klambu sebelum 

dan setelah dibangunnya krib? 

 

1.3 Tujuan Penelitian 

Berikut tujuan penelitian dalam penulisan Tugas Akhir. 

1. Mengetahui distribusi kecepatan pada sungai di ruas hulu Bendung Klambu 

sebelum dan setelah dibangunnya krib. 

2. Mengetahui arah pola aliran yang terjadi di ruas hulu Bendung Klambu sebelum 

dan setelah dibangunnya krib. 

 

1.4 Manfaat Penelitian 

Penelitian ini diharapkan dapat bermanfaat sebagai studi dalam perencanaan 

krib serta penelitian-penelitian selanjutnya. 
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1.5 Batasan Penelitian 

Untuk dapat mempermudah penelitian maka harus adanya batasan penelitian. 

Batasan penelitian pada penelitian ini sebagai berikut: 

1. Penelitian ini dilakukan pada lokasi Bendung Klambu, Kabupaten Grobogan, 

Jawa Tengah. 

2. Simulasi dilakukan pada daerah tikungan di hulu Bendung Klambu. 

3. Model krib digunakan beberapa varian panjang dan jenis. 

4. Aliran steady. 

5. Simulasi tidak memodelkan pola sedimentasi. 

6. Parameter kekasaran sungai sama di sepanjang sungai. 

7. Jumlah krib yang digunakan sama dengan kondisi eksisting. 
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BAB II 
TINJAUAN PUSTAKA 

 
 
 
2.1 Distribusi Kecepatan pada Krib 

Zaid (2018) melakukan penelitian untuk mengetahui distribusi kecepatan pada 

sungai dengan adanya krib. Simulasi dilakukan menggunakan model fisik lalu 

dibuat dalam bentuk grafik distribusi kecepatan. Penelitian dilakukan 

menggunakan dua material yaitu batu dan kayu. Bagian sungai yang diteliti 

memiliki rata-rata lebar sungai 24 m dengan kedalaman 0,8 m. Pengukuran 

kecepatan aliran menggunakan alat SEBA Hydrometrie GmbH yang di pasang di 

tiang besi. Untuk penelitian pada material batu digunakan dua sampel batu dengan 

ketinggian 20% dan 40% dari kedalaman air, sementara material kayu 

menggunakan sampel dengan ketinggian 40% dan 80% dari kedalaman air. Hasil 

distribusi kecepatan dari penggunaan krib pada penelitian dapat dilihat pada 

Gambar 2.1. 

 

 
Gambar 2.1 Distribusi Kecepatan pada Krib Batu dengan Ketinggian 40% 

(kiri) dan 20% (kanan) dari dasar laut. 

(Sumber: Zaid, 2018) 

 

4 
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Gambar 2.2 Distribusi Kecepatan pada Krib Kayu dengan Ketinggian 80% 

(kiri) dan 40% (kanan) dari dasar laut. 

 (Sumber: Zaid, 2018) 

 

Penelitian tersebut menyatakan bahwa krib dari batu yang kedap air membuat 

daerah air yang diam. Untuk krib kayu terdapat pengurangan kecepatan tapi tidak 

ada daerah air yang diam. Hal tersebut dapat disebabkan karena adanya aliran air 

yang melewati daerah bawah krib kayu. Gerusan tanah dasar paling tinggi terjadi 

di ujung krib dengan bahan batu, dimana area endapan terbanyak terdapat pada hulu 

dan hilir struktur krib. 

Pemodelan krib juga dilakukan Suharjoko (2012) untuk menentukan 

penempatan krib terbaik pada tikungan sungai dengan  dua variasi radius (R=40 m 

dan R=30 m), tiga variasi peletakan krib (hilir sungai, tengah tikungan sungai, dan 

¼  busur lingkaran dari hilir sungai), dan tiga variasi panjang krib. Simulasi tersebut 

mendapatkan hasil bahwa pada sungai dengan R=40 m, krib yang diletakkan pada 

¼ busur lingkaran dari hilir memberikan efek paling bagus dalam mengontrol aliran 

sungai. Sedangkan sungai dengan R=30 m, peletakan krib pada hulu tepat sebelum 

tikungan memberikan efek paling bagus dalam mengontrol aliran sungai.  
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Gambar 2.3 Gambar Pola Aliran pada Belokan Sungai dengan R=40 m dan 

Krib pada ¼ Busur Lingkaran 

 (Sumber: Suharjoko, 2012) 

 

2.2 Pola Aliran 

Copeland (1983) membuat pemodelan dengan menempatkan krib pada 

tikungan sungai untuk mengetahui pola aliran pada krib.  Pola aliran yang 

didapatkan pada pemodelan dapat dilihat pada Gambar 2.4. 

 

 
Gambar 2.4 Pola Aliran 

(Sumber: Przedwojski, 1995) 
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Pada gambar pertama, pusaran air terbentuk di antara krib sehingga membuat 

pola dari luar teralihkan dan menahan aliran tidak masuk dalam area antar krib. 

Pada tipe kedua, pusaran air juga terjadi tetapi aliran utama dari luar krib dapat 

masuk diantar krib. Semakin bertambahnya jarak antar krib membuat aliran 

semakin berubah. Yang terakhir pada tipe keenam, krib sudah kehilangan fungsinya 

yang membuat aliran utama masuk dan menggerus pinggiran sungai. 

 
2.3 Model Simulasi Krib 

Mojtahedi dan Basmenji A B (2017) melakukan penelitian tentang pengaruh 

krib dan tanggul pada sungai Ghezel-Ozan. Penelitian tersebut menggunakan 

aplikasi MIKE 21 dengan pendekatan model numerik 2D. Aplikasi tersebut 

terdapat flexible mesh flow untuk mensimulasikan aliran hidrodinamik yang tidak 

tetap dalam 2D (rata-rata kedalaman). 

Penelitian yang dilakukan menghasilkan kesimpulan yaitu bahwa krib 

mempunya efektivitas yang tinggi dalam melindungi tanggul dalam terjadinya 

erosi, hal ini dapat dilihat dari kecepatan aliran yang berkurang pada daerah dekat 

tanggul dan lebih banyak pada tengah sungai. Setelah adanya krib, dalam rentang 

interval tertentu, saluran utama sungai semakin dalam sementara sedimentasi 

terjadi di antara krib dan membuat tanggul lebih stabil. 

 
Gambar 2.5 Pola Aliran dan Vorteks Sekitar Krib 

 (Sumber: Mojtahedi dan Basmenji A B, 2017) 
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Fatimah dan Fauzi (2020) dalam penelitiannya membandingkan penggunaan 

krib dengan jenis yang berbeda pada aliran sungai. Pada penelitian tersebut 

menggunakan aplikasi Surface Water Modelling System (SMS 11.2) Secara teori, 

pinggiran sungai pada tikungan memiliki kecepatan yang lebih tinggi dibanding 

tengah sungai. Pola aliran pada penelitian tersebut sebelum dibangunnya krib dapat 

dilihat pada Gambar 2.6. 

 

 
Gambar 2.6 Pola Aliran Sungai Kreung Aceh Sebelum Adanya Krib 

 (Sumber: Fatimah dan Fauzi, 2020) 

 

Sungai tersebut dilakukan simulasi untuk pemasangan krib dengan berbagai 

jenis dan dimensi krib. Pada simulasi tersebut didapatkan hasil bahwa krib dengan 

kemiringan 30 derajat dengan panjang 9 meter lebih baik dalam mengurangi 

pusaran arus daripada panjang 7 meter. 
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Gambar 2.7 Pola Aliran Sungai Kreung Aceh menggunakan Krib 30 derajat 

Panjang 9 Meter (Atas) dan 7 Meter (Bawah) 

(Sumber: Fatimah dan Fauzi, 2020) 

 

2.3.1 Simulasi Pada Telemac-Mascaret 

Saberi dan Galoie (2017) melakukan penelitian menggunakan aplikasi 

Telemac 3D dengan memodelkan beberapa bentuk krib yang berbeda. Penelitian 

yang dilakukan untuk mengetahui pengaruh penggunaan krib serta perbedaan pada 

tiap bentuk krib. Pemodelan menggunakan mesh dengan ukuran antara 0,04-0,05 m 

untuk tiap sisi. Time step digunakan 0,1 detik dengan debit dan tinggi yang konstan. 

Koefisien Manning yaitu 0,02 untuk dasar sungai dan dinding halus tanpa friksi 

pada daerah dinding sungai. 

Penelitian tersebut mendapatkan hasil bahwa pada krib tanpa flanges terjadi 

tegangan geser pada dasar sungai paling tinggi daripada krib dengan flanges. 

Pengikisan tertinggi terjadi pada daerah sekitar krib dan pada daerah hulu krib. 

Adanya flanges pada krib mempengaruhi tegangan geser pada dasar sungai. 

Semakin tinggi panjang flanges akan menyebabkan kecepatan pada daerah 

belakang flanges berkurang. 
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Gambar 2.8 Tegangan Geser Dasar Sungai Pada Krib Tanpa Flanges 

(Sumber : Saberi dan Galoie, 2017) 

 

 
Gambar 2.9 Tegangan Geser Dasar Sungai Pada Krib Dengan Flanges 

 (Sumber : Saberi dan Galoie, 2017) 

 

2.4 Keaslian Penelitian 

Berdasarkan tinjauan dari penelitian terdahulu, pada penelitian kali ini untuk 

simulasi aliran pada krib digunakan aplikasi Telemac 2D serta desain krib yang di 

gunakan yaitu beberapa variasi panjang dan jenis.  



11 
 

 
 

BAB III 
LANDASAN TEORI 

 
 
 
3.1 Saluran Terbuka 

  Saluran terbagi menjadi dua jenis yaitu saluran tertutup dan saluran terbuka. 

Bambang Triatmodjo (2003) menjelaskan bahwa saluran terbuka adalah saluran 

dimana air mengalir dengan muka air bebas. Tekanan di permukaan air pada semua 

titik di sepanjang saluran terbuka adalah sama. Saluran terbuka berbeda dengan 

saluran tertutup karena terdapat banyak variabel aliran yang sangat tidak teratur 

seperti tampang lintang saluran, kekasaran, kemiringan dasar, belokan, debit aliran 

dan sebagainya. 

 Saluran terbuka terbagi dua jenis yaitu saluran buatan dan saluran alam. 

Saluran buatan seperti irigasi, drainase, saluran untuk keperluan industri dan 

berbagai jenis saluran buatan lainnya memiliki karakteristik aliran yang seragam di 

sepanjang saluran. Oleh karena itu, untuk menganalisis aliran pada saluran alam 

lebih kompleks daripada saluran buatan. Salah satu jenis saluran terbuka alam 

adalah sungai. 

 Sungai adalah alur atau wadah air alami dan/atau buatan berupa jaringan 

pengaliran air beserta air di dalamnya, mulai dari hulu sampai muara, dengan 

dibatasi kanan dan kiri oleh garis sempadan (PP No. 38 tahun 2011). Sungai adalah 

sebuah sistem alur alam yang secara menerus menyesuaikan dirinya terhadap 

perubahan lingkungan sekitarnya dalam bentuk aksi dan reaksi. Penyesuaian sungai 

terhadap lingkungan dapat berjalan pelan dan tak terlihat tetapi juga dapat berjalan 

cepat dan mendadak. Aliran air pada sungai yang memiliki tampang melintang 

tidak beraturan akan terjadi perubahan kecepatan dan kedalaman yang 

menyesuaikan bentuk dari geometri sungai.  

 

 

11 
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3.2 Klasifikasi Aliran 

Pengklasifikasian aliran dibagi menjadi berbagai tipe tergantung kriteria yang 

digunakan. Klasifikasi aliran berdasarkan karakteristik ruang terdapat aliran 

seragam (uniform flow) dan aliran tidak seragam (non uniform flow). Klasifikasi 

aliran berdasarkan karakteristik waktu terdapat aliran tetap (steady flow) dan aliran 

tidak tetap (unsteady flow). 

 

 
Gambar 3.1 Klasifikasi Aliran Pada Saluran Terbuka 

  
1. Berdasarkan fungsi ruang 

a. Aliran Seragam (uniform flow) 

Aliran disebut seragam jika variabel pada aliran sepanjang saluran yang 

ditinjau seperti kedalaman, tampang basah, kecepatan dan debit adalah 

konstan. 

 
𝑑ℎ
𝑑𝑥

= 0 , 𝑑𝐴
𝑑𝑥

= 0  , 𝑑𝑄
𝑑𝑥

= 0     (3.1) 
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Gambar 3.2 Aliran Seragam 

 

b. Aliran tidak seragam (varied flow) 

Aliran disebut tidak seragam jika terjadi variabel tidak konstan sepanjang 

aliran yang ditinjau. Variabel yang dimaksud yaitu kedalaman, tampang 

basah dan kecepatan aliran. 

 
𝑑ℎ
𝑑𝑥

≠ 0 , 𝑑𝐴
𝑑𝑥

≠ 0  , 𝑑𝑄
𝑑𝑥

≠ 0     (3.2) 

 

 
Gambar 3.3 Tidak Seragam 

 

2. Berdasarkan fungsi waktu 

a. Aliran permanen (steady flow) 

Aliran permanen merupakan aliran yang memiliki variabel aliran yang tetap 

pada setiap tampang di sepanjang saluran dan tidak berubah terhadap waktu. 

Variabel aliran yang dimaksud yaitu seperti kedalaman, kecepatan dan debit. 
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𝑑ℎ
𝑑𝑡

= 0 , 𝑑𝐴
𝑑𝑡

= 0  , 𝑑𝑄
𝑑𝑡

= 0     (3.3) 

 
Gambar 3.4 Aliran Permanen 

 

b. Aliran tidak permanen (unsteady flow) 

Aliran disebut tidak permanen jika variabel aliran seperti kedalaman, 

kecepatan dan debit pada setiap tampang di sepanjang saluran berubah 

terhadap waktu. 

 
𝑑ℎ
𝑑𝑡

≠ 0 , 𝑑𝐴
𝑑𝑡

≠ 0  , 𝑑𝑄
𝑑𝑡

≠ 0     (3.4) 

 

 
Gambar 3.5 Aliran Tidak Permanen 

 
3.3 Distribusi Kecepatan 

Kecepatan tiap titik pada saluran terbuka sangat bervariasi. Hal ini tergantung 

dari banyak faktor seperti bentuk saluran, kekasaran dinding, dan juga debit aliran. 

Dengan menggunakan koordinat kartesius, aliran mempunyai tiga komponen arah, 

tetapi komponen arah vertikal dan lateral memiliki nilai yang kecil sehingga dapat 

diabaikan. Oleh karena itu, komponen arah yang diperhitungkan hanya kecepatan 

aliran yang searah.  
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Variasi dari komponen kecepatan tergantung pada kedalaman air dari 

permukaan. Permukaan  bebas dan gesekan di sepanjang dinding saluran  terbuka 

mengakibatkan pembagian kecepatan pada  saluran    terbuka    tidak    merata    pada 

penampang saluran (Chow, 1985). Beberapa contoh tipikal variasi kecepatan 

terhadap kedalaman air dapat dilihat pada Gambar 3.6. 

 
Gambar 3.6 Distribusi Kecepatan Pada Saluran Terbuka 

 (Sumber : Triatdmojo, 1993) 

 

Gambar di atas menunjukkan bahwa kecepatan minimum terjadi pada daerah 

sekitar dinding batas yaitu pada dasar dan tebing. Kecepatan semakin bertambah 

besar jika semakin dekat ke permukaan. Sementara itu, kecepatan maksimum 

terjadi pada daerah tengah lebar saluran dan di dekat bawah permukaan. Hal 

tersebut terjadi karena terjadi gesekan antara zat cair dengan tebing saluran, serta 

gesekan antara zat cair dengan dara pada permukaan. 

Distribusi kecepatan pada tikungan sungai yaitu aliran mengalami percepatan 

dan perlambatan (Purnama, 2016). Kecepatan aliran pada dalam belokan 

mengalami peningkatan saat memasuki awal belokan dan menurun saat melewati 

akhir belokan. Sementara pada luar belokan, kecepatan mengalami penurunan saat 

memasuki awal belokan dan mengalami peningkatan saat melewati akhir belokan. 



16 
 

 
 

Hal tersebut menyebabkan sedimen memiliki kecenderungan untuk meningkatkan 

terjadinya deposisi sedimen pada dalam belokan dan erosi pada dasar saluran di 

luar belokan.  

 
Gambar 3.7 Distribusi Kecepatan Pada Belokan Sungai 

(Sumber : Ferguson dan Parsons, 2003) 

 

3.4 Koefisien Kekasaran Manning 

Nilai koefisien kekasaran Manning ditentukan  berdasarkan pada beberapa 

faktor sehingga memiliki nilai yang sangat bervariasi (Brunner, 2010). Beberapa 

faktor dalam menentukan nilai koefisien kekasaran Manning sebagai berikut: 

1. Kekasaran permukaan. 

2. Vegetasi. 

3. Ketidakteraturan saluran. 

4. Alinyemen saluran. 

5. Penggerusan dan deposisi.  

6. Struktur penghambat. 

7. Ukuran dan bentuk dari saluran. 

8. Tinggi muka air dan debit. 

9. Perubahan musim. 

10. Temperature. 
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Chow (1959) dalam Brunner (2010) memberikan acuan untuk menentukan 

nilai dari koefisien kekasaran Manning yang dibagi berdasarkan nilai minimum, 

normal, dan maksimum seperti yang ditunjukkan pada Tabel 3.1. 

 

Tabel 3.1 Perkiraan Penentuan Nilai Koefisien Manning 

No Saluran Alam Minimum Normal Maksimum 
1 Sungai Utama       

  

a. Bersih, lurus, tidak ada 
celah/palung sungai. 0,025 0,03 0,033 

b. Sama seperti (1.a) ditambah 
dengan batu dan gulma 0,03 0,035 0,04 

  

c. Bersih, berliku-liku, ada 
beberapa kolam dan dangkalan 0,033 0,04 0,045 

d. Sama seperti (1.c) ditambah 
dengan beberapa batu dan 
gulma 

0,035 0,045 0,05 

e. Sama seperti (1.d) lebih 
dangkal, ada beberapa 
kemiringan saluran dan 
tampang yang tidak efektif 

0,04 0,048 0,055 

f. Sama seperti (1.d) ditambah 
dengan batu 0,035 0,05 0,06 

g. Penggal sungai yang lambat, 
bergulma, dan berpalung. 0,05 0,07 0,08 

h. Penggal sungai dengan 
banyak gulma, palung, alur 
banjir dengan banyak pohon 
berbatang keras dan semak-
semak. 

0,07 0,1 0,15 

2 Dataran Banjir       

  

a. Padang rumput tanpa semak.       
1) Rumput pendek 0,025 0,03 0,035 
2) Rumput tinggi 0,03 0,035 0,05 
b. Area pertanian/budidaya       
1) Tidak ada tanaman 0,02 0,03 0,04 
2) Tanaman dewasa satu baris 0,025 0,035 0,045 
3) Tanaman dewasa satu bidang 0,03 0,04 0,05 
c. Semak-semak       
1) Semak-semak tersebar dan 
banyak gulma 0,035 0,05 0,07 
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Lanjutan Tabel 3.2 Perkiraan Penentuan Nilai Koefisien Manning 

No Saluran Alam Minimum Normal Maksimum 

 

2) Semak-semak ringan dan 
pepohonan kecil pada musim 
dingin 

0,035 0,05 0,06 

3) Semak-semak ringan dan 
pepohonan kecil pada musim 
panas 

0,04 0,06 0,08 

4) Semak-semak medium-
rimbun pada musim dingin 0,045 0,07 0,11 

5) Semak-semak medium-
rimbun pada musim panas 0,07 0,1 0,16 

d. Pepohonan       
1) Lahan yang dibuka dengan 
tanggul pohon, dan tidak ada 
tunas yang tumbuh 

0,03 0,04 0,05 

2) Sama dengan {(2.d.1)} tetapi 
dengan banyak tunas yang 
tumbuh 

0,05 0,06 0,08 

  3) banyak pohon berbatang 
keras, sedikit pohon muda, 
elevasi aliran masih di bawah 
cabang ranting pohon 

0,08 0,1 0,12 

4) Sama dengan {(2.d.3)} tetapi 
elevasi aliran sampai dengan 
cabang-ranting pohon 

0,1 0,12 0,16 

5) banyak pohon Willow pada 
musim panas 0,11 0,15 0,2 

3 Saluran di pegunungan tidak 
ada vegetasi pada saluran, 
kemiringan dasar curam, 
dengan pepohonan dan semak- 
semak yang terendam di 
tampungan 

      

  

a. Dasar: gravels, cobbles, dan 
sedikit boulders 0,03 0,04 0,05 

b. Dasar: gravels, cobbles, dan 
banyak boulders 0,04 0,05 0,07 

Sumber : Brunner (2010) 
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3.5 Perilaku Aliran Pada Tikungan Sungai 

Aliran pada tikungan sungai terdapat gaya sentrifugal yang akan menyebabkan 

munculnya arus melintang sungai. Arus melintang sungai beserta aliran utama 

sungai akan menyebabkan pembentukan aliran helicoidal. Arus melintang memiliki 

kecepatan dengan berkisar antara 10% - 15% dari kecepatan arah utama aliran 

(Kinori, 1984 dan Legono, 1986). Perilaku aliran pada tikungan sungai dapat 

menyebabkan terjadinya erosi terutama pada sungai yang berkelok-kelok. Erosi 

akan terjadi pada daerah sisi luar belokan dan sedimentasi terjadi pada daerah dalam 

belokan. Pengikisan tanah paling banyak terjadi pada daerah luar tikungan, 

sedangkan sedimentasi paling banyak terjadi pada daerah dalam tikungan. 

Superelevasi pada tikungan mempengaruhi tingkat pengikisan pada sungai. 

(Darwizal, M. Subhi, 2006) .  

  

 
Gambar 3.8 Skema Aliran pada Tikungan Sungai (Graf & Altinakar, 1998) 

(Sumber : Purnama, 2016) 
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Gambar 3.9 Pola Aliran Pada Tampak Melintang Belokan Sungai 

 (Sumber : Blanckaert, 2002) 

 
3.6 Krib 

3.6.1 Definisi Krib 

Krib merupakan salah satu jenis bangunan pengatur sungai. Bangunan 

pengatur sungai adalah bangunan yang dibangun untuk mengarahkan dan mengatur 

aliran sungai, serta mengatur dasar sungai atau menambah kedalaman sungai 

dengan maksud untuk stabilisasi alur sepanjang jalan (alignment) ruas sungai 

tertentu. Sedangkan pengertian dari krib sendiri adalah bangunan yang dibuat mulai 

dari tebing sungai ke arah tengah guna mengatur arus sungai (BPSDM, 2017). 

 

 
Gambar 3.10 Krib 

(Sumber : Rijkswaterstaat) 
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3.6.2 Fungsi Krib 

Sebagai bangunan pengatur sungai, krib memiliki fungsi yang bermacam-

macam. Qiu-cai (2009) menjelaskan bahwa fungsi dari krib yaitu untuk memotong 

aliran air sehingga menjauh dari pinggiran pantai atau sungai untuk melindungi 

daerah hilir.  

Bangunan krib memiliki berbagai fungsi. Beberapa fungsi dari krib dapat dilihat 

sebagai berikut: 

1. Untuk melindungi tebing secara tidak langsung, khususnya untuk tebing yang 

terletak pada daerah potensial seperti pelindung tebing sungai, jembatan, 

bangunan fasilitas umum, tanggul, dan jalan raya. 

2. Untuk pengarah aliran sungai seperti membelokkan dan mengubah arah aliran 

dengan tujuan sebagai berikut: 

a. Krib untuk mengatur debit agar masuk ke percabangan sebagai suplesi, agar 

aliran masuk ke bangunan pengambilan.  

b. Krib untuk memperbaiki arah arus apabila di bangunan pengambilan 

(bendung, pompa air, pintu air) terjadi perubahan arah arus.  

c. Krib untuk memperbaiki pola dan arah aliran pada alur sungai tidak menentu 

misalnya pada sungai di dataran rendah.  

3. Untuk pengarah sehingga dapat memperbaiki alinyemen sungai dengan 

keperluan tertentu, seperti:  

a. Mempertahankan lebar dan kedalaman sungai yang dipakai keperluan 

navigasi maka krib dipasang pada tebing kiri dan kanan sungai.  

b. Memperbaiki alinyemen karena terjadinya longsoran tebing karena arus maka 

krib dipasang secara serial guna memacu terjadinya endapan pada bagian 

tebing  tersebut.  

 

3.6.3 Klasifikasi Krib 

Krib diklasifikasikan berdasarkan tipe konstruksi sebagai berikut: 

1. Krib Permeabel 

Krib permeable atau krib tembus air merupakan tipe krib yang aliran air sungai 

dapat mengalir melalui krib. Bangunan ini akan melindungi tebing terhadap 
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gerusan arus sungai dengan cara meredam energi yang terkandung dalam aliran 

sepanjang tebing sungai. 

2. Krib Impermeabel 

Krib impermeabel atau krib tahan air juga disebut krib padat karena air sungai 

tidak dapat mengalir melalui tubuh krib. Bangunan ini digunakan untuk 

membelokan arah arus sungai, hal tersebut menyebabkan sering terjadi gerusan 

yang cukup dalam di depan ujung krib atau bagian sungai di sebelah hilirnya. 

 
3.6.4 Mekanisme Kerja Krib 

Mekanisme aliran pada sekitar krib dan deformasi pada pinggiran sungai 

dapat dilihat pada Gambar 3.10. 

 
Gambar 3. 11 Ilustrasi Aliran pada Krib 

 (Sumber : Qiu-cai, 2009) 

 

Aliran pada daerah krib terdapat tiga bagian termasuk daerah air refluks, 

aliran detensi/penahanan dan aliran utama sungai. Aliran utama terdapat pada ujung 

krib  hingga pinggiran sungai yang tidak terdapat krib, aliran ini merupakan aliran 

linear. Aliran refluks terdapat pada hilir krib dimana tekanan dan kecepatan aliran 

air berkurang yang kemudian membuat aliran berbentuk rotasi (helicoidal). Aliran 

detensi terletak pada hulu krib dimana aliran air terhalang oleh krib dan terjadi 

refleksi yang membentuk aliran rotasi. 
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3.7 Telemac 2D 

Program Telemac 2D merupakan model numerik dua dimensi yang 

menyelesaikan permasalahan hidrodinamika dengan asumsi rata-rata kedalaman 

pada aliran permukaan bebas. Aplikasi tersebut dapat memecahkan persamaan 

hidrodinamika dengan menggunakan metode elemen hingga. Hasil dari komputasi 

program tersebut berupa kedalaman air dan dua komponen kecepatan yang dihitung 

pada tiap titik jaringan segitiga/mesh. Program Telemac 2D memiliki banyak fungsi 

seperti mencari distribusi kecepatan dan pola aliran sungai. 

 

3.7.1 Persamaan Aliran 

Telemac kemudian memproses rumus hidrodinamika yaitu persamaan 

kontinuitas dan persamaan momentum pada sumbu x dan y yang diintegrasikan 

terhadap rerata kedalaman (depth-averaged). Persamaan tersebut dapat dilihat 

sebagai berikut: (User Guide for Telemac 2D). 

 
𝜕ℎ
𝜕𝑡

+ 𝑢 · ∇(ℎ) + ℎ𝑑𝑖𝑣(𝑢) = 𝑆ℎ           persamaan kontinuitas (3.1) 

 
𝜕𝑢
𝜕𝑡

+ 𝑢 · ∇(𝑢) =  −𝑔 𝜕𝑍
𝜕𝑥

+ 𝑆𝑥 + 1
ℎ

𝑑𝑖𝑣(ℎ𝑣𝑡∇𝑢)      momentum sepanjang x (3.2) 

  
𝜕𝑣
𝜕𝑡

+ 𝑢 · ∇(𝑣) =  −𝑔 𝜕𝑍
𝜕𝑦

+ 𝑆𝑦 + 1
ℎ

𝑑𝑖𝑣(ℎ𝑣𝑡∇𝑣)      momentum sepanjang y (3.3) 

 

Dengan: 

 h (m) = kedalaman air 

 u,v  (m/s) = kecepatan 

 g (m/s2) = percepatan gravitasi 

 vt (m2/s) = koefisien momentum 

 Z (m) = elevasi permukaan 

 t (s) = waktu 

 x,y (m) = koordinat horizontal 

 Sh (m/s) = aliran potensial pada fluida 
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 Sx, Sy (m/s2) = source or sink pada persamaan dinamika 

Persamaan menggunakan koordinat Cartesian dan dapat juga diproses dengan 

menggunakan koordinat spherical. 

 

3.7.2 Debit Aliran 

Telemac 2D memproses rumus debit aliran. Pada bangunan seperti bendung 

dan krib dianggap sebagai aliran linear. Rumus yang digunakan dibedakan menjadi 

dua yaitu pada bangunan yang terendam dan tidak terendam air. Bangunan 

dikatakan tidak terendam air jika: 

 

upstream level <  𝑡ℎ𝑟𝑒𝑠ℎ𝑜𝑙𝑑 𝑙𝑒𝑣𝑒𝑙+2×𝑢𝑝𝑠𝑡𝑟𝑒𝑎𝑚 𝑙𝑒𝑣𝑒𝑙
3

    (3.4) 

 

Adapun rumus dalam menghitung aliran pada tiap titik sebagai berikut: 

1. Bangunan yang terendam air 

Q =  µ√2𝑔(𝑢𝑝𝑠𝑡𝑟𝑒𝑎𝑚 − 𝑡ℎ𝑟𝑒𝑠ℎ𝑜𝑙𝑑)
2
3      (3.5) 

 

2. Bangunan tidak terendam air 

Q = (2
3

(1
3
))−1 ×  µ√2𝑔(𝑑𝑜𝑤𝑠𝑡𝑟𝑒𝑎𝑚 − 𝑡ℎ𝑟𝑒𝑠ℎ𝑜𝑙𝑑)1√(𝑢𝑝𝑠𝑡𝑟𝑒𝑎𝑚 − 𝑡ℎ𝑟𝑒𝑠ℎ𝑜𝑙𝑑)  (3.6) 

 

Nilai dari µ tergantung pada bentuk dan kekasaran bendungan dengan rentang 

nilai antar 0,4-0,5. 

 
3.7.3 Mesh 

Program Telemac2D menggunakan file geometri berupa bentuk mesh untuk 

mensimulasikan aliran. Penggunaan mesh bertujuan untuk memecah bentuk 

geometri sungai sehingga dapat mendefinisikan bentuk fisik objek sungai 

sebagaimana mestinya. 

Bagian mesh terdiri dari vertex, edge, dan face. Vertex merupakan titik yang 

terletak pada koordinat kartesius. Gabungan dari dua vertex akan membentuk garis 

yang disebut edge. Gabungan dari tiga vertex dan edge yang terbentuk dalam bidang 
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permukaan berupa kurva tutup akan membentuk face. Kumpulan dari vertex, edge, 

dan face akan menjadi sebuah objek utuh yang disebut mesh. Mesh yang digunakan 

pada simulasi menggunakan Telemac2D merupakan mesh berbentuk segitiga. 

 
3.7.4 Aplikasi Bantuan 

Simulasi menggunakan Telemac2D membutuhkan bantuan beberapa aplikasi 

untuk membuat bentuk sungai, membuat file parameter, dan memvisualisasikan 

hasil simulasi. Adapun beberapa aplikasi yang digunakan sebagai berikut: 

1. BlueKenue 

BlueKenue adalah aplikasi untuk membuat geometri sungai berupa bentuk mesh 

dan memvisualisasikan hasil simulasi dari Telemac2D. 

2. FudaaPrepro 

FudaaPrepro adalah aplikasi untuk memasukkan data parameter yang akan 

digunakan pada running simulasi Telemac2D. 
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BAB IV 
METODOLOGI PENELITIAN 

 
 
 
4.1 Tinjauan Umum 

Penelitian yang dilakukan bersifat kuantitatif yaitu penelitian yang berdasarkan 

pada data-data sebagai acuan dalam menganalisis. Kemudian dilanjutkan dengan 

melakukan kajian penelitian tentang hasil dari analisis yang digunakan. Penelitian 

ini dibuat sistematis mulai dari persiapan penelitian, penyusunan model simulasi, 

pelaksanaan beberapa jenis pemodelan menggunakan program Telemac 2D, dan 

pembacaan hasil simulasi. Krib eksisting pada belokan di hulu Bendung Klambu 

yaitu berjumlah empat buah dengan jenis permeabel sepanjang 32 m. 

Jumlah krib yang digunakan sesuai dengan jumlah krib eksisting pada hulu 

Bendung Klambu sejumlah empat buah. Panjang krib eksisting pada hulu Bendung 

Klambu yaitu 32 m sehingga pemilihan panjang pertama digunakan krib dengan 

panjang 30 m. Untuk membandingkan krib eksisting digunakan dua variasi panjang 

dengan kelipatan 10 m sehingga variasi panjang yang akan disimulasikan yaitu 30 

m, 40 m, dan 50 m. Pemodelan krib juga dilakukan untuk dua jenis krib yaitu 

permeabel dan impermeabel. Kedua jenis tersebut digunakan untuk 

membandingkan jenis krib terbaik dalam meningkatkan kecepatan di dalam 

belokan sungai. 

 

4.2 Lokasi Penelitian 

Penelitian ini dilakukan pada bangunan krib di Bendung Klambu. Kabupaten 

Grobogan, Kecamatan Klambu, Jawa Tengah. Denah dari objek penelitian dapat 

dilihat pada Gambar 4.1. 
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Gambar 4.1 Lokasi Penelitian 

 (Sumber : Google Earth) 

4.3 Data Penelitian 

Dalam melakukan simulasi pemodelan membutuhkan data yang sesuai dengan 

yang ada di lapangan. Pada penelitian ini dilakukan dengan menggunakan data 

sekunder dan studi literatur. Analisis pada program Telemac 2D membutuhkan 

beberapa data. Data-data yang dibutuhkan sebagai berikut: 

1. Peta topografi sungai sekitar Bendung Klambu. 

2. Data debit. 

3. Kondisi batas sungai. 

 

4.4 Tahapan Penelitian 

Adapun tahapan penelitian yang digunakan pada penelitian ini sebagai berikut: 

1. Tahapan Pengumpulan Data 

Tahapan ini merupakan pengumpulan data berupa topografi sungai, data debit 

dan kondisi batas sungai. 

2. Tahapan Pengolahan Data 

Analisis yang dilakukan menggunakan aplikasi Telemac 2D dengan tahapan 

pengolahan data sebagai berikut: 
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a. Input Data 

Input data yaitu memasukkan data topografi sungai dan pembuatan 

boundary sungai melalui aplikasi BlueKenue. 

b. Processing 

Proses pemodelan pembuatan mesh dan interpolasi mesh pada aplikasi 

BlueKenue dan input parameter pada aplikasi Fudaa Prepro. Mesh dibuat 

dengan tiga varian panjang (30 m, 40 m, dan 50 m), serta dua jenis krib 

(permeabel dan impermeabel). Parameter yang dimasukkan yaitu Initial 

Elevation, Law of Bottom Friction, Friction Coefficient, dan Prescribed 

Charges. Setelah itu, dilakukan running simulasi menggunakan aplikasi 

Telemac 2D. 

c. Output 

Tahapan ini berupa pembacaan hasil perhitungan pada aplikasi. Hasil dari 

perhitungan tersebut berupa gambar distribusi kecepatan dan gambar pola 

aliran sungai sebelum dan setelah adanya krib. 

3. Tahapan Pembahasan dan Pelaporan 

Tahapan ini berisi penyusunan pembahasan dan pelaporan yang berisi jawaban 

dari hasil hipotesa secara sistematis dan lengkap. Pada tahapan ini juga di tarik 

kesimpulan dari hasil pembahasan yang menjawab tujuan dari penelitian ini. 
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4.5 Bagan Alir Penelitian 

Adapun bagan alir dari penelitian yang dilakukan dapat dilihat pada Gambar 

4.2. 

 
 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mulai 

Studi Pustaka dan Pengumpulan Data: 
 

- Peta Topografi sekitar Bendung 
Klambu 

- Debit Aliran 
- Kondisi Batas Sungai 

Input Data 
 

Pemasukkan data berupa topografi 
sungai dan pembuatan boundary sungai 
pada aplikasi BlueKenue 

Pembuatan Mesh 
 

Pembuatan mesh sungai dengan properti yang 
sudah ditentukan dan interpolasi mesh sungai pada 
aplikasi BlueKenue. Mesh dibuat beberapa varian 
yaitu 30 m, 40 m, dan 50 m, serta dua jenis krib 
yaitu permeabel dan impermeabel 

A
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Model tidak 
selesai running 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar 4. 2 Bagan Alir Penelitian 

 
 
 

Hasil dan Analisis Data: 
 

- Distribusi Kecepatan 
- Pola Aliran 

 

Kesimpulan 
 
 

 

Selesai 
 

Input Parameter 
 
Pembuatan file parameter melalui aplikasi 
Fudaa Prepro. Parameter yang dimasukkan: 
 

- Initial Elevation,  
- Law of Bottom Friction 
- Friction Coefficient  
- Prescribed Charges 
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BAB V 
ANALISIS DAN PEMBAHASAN 

  
 
 
5.1 Pembuatan Mesh Sungai 

Pembuatan mesh sungai merupakan tahapan awal untuk melakukan simulasi 

aliran menggunakan Telemac2D. Mesh merupakan beberapa jaring segitiga yang 

membentuk suatu sungai. Aplikasi yang digunakan pada proses ini yaitu 

BlueKenue yang dapat berfungsi untuk menampilkan kondisi sungai. Pembuatan 

mesh selengkapnya dapat dilihat pada Lampiran 1. Proses yang dilakukan dalam 

pembuatan mesh sungai antara lain membuat batas kanan dan kiri tepi sungai, 

membuat outline, membuat mesh saluran sungai, interpolasi batimetri sungai, dan 

membuat batas hulu dan hilir sungai. Bentuk garis batas kanan dan kiri sungai dapat 

dilihat pada Gambar 5.1. 

 

 
Gambar 5.1 Garis Batas Kanan dan Kiri Sungai 
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 Mesh sungai dibuat dengan jarak 15 meter antar titik sepanjang sungai dan 

total 10 meter antar titik pada melintang sungai sesuai Gambar 5.2. Hasil dari 

pembuatan mesh dapat dilihat pada Gambar 5.3. 

 

 
Gambar 5.2 Properti Mesh 

 

 
Gambar 5.3 Mesh Klambu 
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 Hasil dari pembuatan mesh hanya berupa bentuk jaring segitiga sehingga 

perlu dilakukan interpolasi agar kedalaman sungai sesuai dengan kondisi 

sebenarnya. Interpolasi dilakukan dengan menggunakan salah satu fitur aplikasi 

BlueKenue yaitu T3 Channel Mesher dan Map Object. Hasil interpolasi mesh 

sungai pada Bendung Klambu dapat dilihat pada Gambar 5.4. 

 

 
Gambar 5.4 Mesh Setelah Interpolasi 

 
Pemodelan krib pada Telemac2D yaitu dengan cara menghapus face dari 

mesh sehingga terbentuk island. Pemodelan krib impermeable yaitu dengan cara 

menghapus seluruh face sesuai dengan panjang rencana, sementara pemodelan krib 

permeabel yaitu penghapusan face secara selang seling dengan panjang sesuai 

rencana.  

Mesh setelah hasil interpolasi perlu ditentukan kondisi batas agar dapat 

running pada Telemac2D. Kondisi batas dibuat pada inlet sungai dengan nama 

“Boundary 1” dan outlet sungai dengan nama “Boundary 2”. Pembuatan kondisi 

batas dapat dilihat pada Gambar 5.5. 

110 m 
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Gambar 5. 5 Pembuatan Kondisi Batas Sungai 

 

5.2 Input Parameter 

Parameter untuk simulasi aliran ditentukan berdasarkan kondisi aliran sungai. 

Simulasi yang akan dilakukan menggunakan kondisi aliran steady. Aplikasi yang 

digunakan untuk membantu proses input parameter yaitu Fudaa Prepro. Beberapa 

hal yang ditetapkan yaitu sebagai berikut: 

1. Initial Elevation 

Initial elevation yaitu elevasi awal sungai di hulu sungai. Elevasi yang 

dimasukkan sesuai dengan data simulasi 1D yaitu 17,33 m yang didapatkan 

melalui penelitian langsung dilapangan oleh Pradipta (2018). 

2. Law of Bottom Friction  

Law of bottom friction yaitu parameter kekasaran sungai. Parameter kekasaran 

sungai yang digunakan yaitu Manning. 

3. Friction Coefficient  

Friction coefficient yaitu nilai dari koefisien kekasaran sungai. Berdasarkan 

topografi sungai dimana pada bagian sungai yang akan ditinjau terdapat kolam 

dan kecepatan yang rendah serta beberapa tanaman sehingga nilai koefisien 
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yang akan digunakan mengacu pada Tabel 3.2 poin 1.g. yang berkisar antara 

0,05-0,08. Nilai koefisien Manning yang digunakan yaitu 0,06. 

4. Prescribed Flowrates 

Prescribed flowrates yaitu debit sungai yang masuk ke inlet sungai. Data debit 

sungai yang digunakan yaitu 1150 m3/s yang didapatkan melalui penelitian 

langsung dilapangan oleh Pradipta (2018). 

Beberapa hal lain terkait dengan output dan proses simulasi seperti time step 

dan jumlah iterasi. 

 

5.3 Simulasi Aliran Sungai 

Simulasi aliran menggunakan aplikasi Telemac2D membutuhkan beberapa 

data yaitu file mesh dan parameter. Telemac2D melakukan perhitungan sebanyak 

jumlah iterasi. Iterasi dilakukan untuk mencapai akurasi dalam menyelesaikan 

persamaan hidrodinamika. Salah satu contoh hasil iterasi pada solver Telemac2D 

dapat dilihat pada Gambar 5.5. 

Tahapan iterasi diawali dengan perhitungan volume air pada sungai, debit 

aliran yang masuk pada inlet sungai (Flux Boundary 1), dan debit aliran yang keluar 

pada outlet sungai (Flux Boundary 2). Setelah itu, proses perhitungan menggunakan 

persamaan hidrodinamika. 

 

 
Gambar 5.6 Proses Simulasi Aplikasi Telemac 2D 
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5.4 Analisis Hasil 

Simulasi dilakukan dengan menggunakan beberapa macam tipe krib dengan 

panjang dan jenis krib yang berbeda. Hasil yang didapatkan berupa pola aliran dan 

distribusi kecepatan pada sungai. Berikut hasil simulasi beserta analisis yang 

dilakukan. 

5.4.1 Simulasi Tanpa Krib 

Simulasi awal yang dilakukan yaitu simulasi aliran sungai sebelum adanya 

krib. Hasil simulasi berupa distribusi kecepatan pada sungai tanpa krib dapat dilihat 

pada Gambar 5.7. 

 

 
Gambar 5.7 Distribusi Kecepatan Sungai Tanpa Krib  

 

Gambar di atas memperlihatkan bahwa terdapat aliran yang rendah di daerah 

dalam belokan sungai sehingga memungkinkan terjadinya sedimentasi di daerah 

tersebut. Kecepatan aliran sebelum memasuki belokan sekitar 1,67 m/s. Setelah 

memasuki belokan, kecepatan aliran dalam belokan berkisar 0-0,185 m/s dan 

kecepatan aliran luar belokan berkisar 0,74-1,67 m/s. 
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Gambar 5.8 Pola Aliran Sungai Tanpa Krib 

  

Pola aliran sungai tanpa krib dapat dilihat pada Gambar 5.8. Daerah dalam 

belokan sungai terjadi pusaran air yang dapat dilihat pada hasil simulasi pola aliran 

di atas. Pusaran air tersebut memungkinkan terjadinya penumpukan sedimen di 

daerah dalam sungai. 

 

5.4.2 Simulasi Dengan Krib 30 m 

Simulasi dilakukan menggunakan krib dengan panjang 30 m sejumlah empat 

buah. Krib yang digunakan yaitu jenis krib permeabel dan impermeabel. Bentuk 

mesh yang akan dilakukan simulasi dapat dilihat pada Gambar 5.9. 

1. Permeabel 

Hasil simulasi berupa distribusi kecepatan pada krib permeabel dapat dilihat 

pada Gambar 5.10. Krib dengan tipe permeabel mendapatkan hasil distribusi 

kecepatan di dalam belokan sungai berkisar antara 0-0,74 m/s. Kecepatan 

aliran sebelum adanya krib di daerah dalam belokan sungai berkisar antara 0-

0,18 m/s sehingga dengan adanya krib permeabel 30 m terjadi peningkatan 

peningkatan kecepatan. Sementara pada daerah antar krib kecepatan berkisar 

antara 0-0,74 m/s. 



38 
 

 
 

 

 

 

 
Gambar 5.9 Bentuk Mesh Sungai Dengan Krib 30 m Impermeabel (Atas) 

dan Permeabel (Bawah) 

 

30 m 

30 m 
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Gambar 5.10 Distribusi Kecepatan Sungai Dengan Krib Permeabel 30 m 

 

Pola aliran sungai dengan krib permeabel 30 m dapat dilihat pada Gambar 

5.11. Pola aliran pada daerah dalam belokan sungai yaitu terbentuknya 

pusaran air. Daerah antar krib memiliki pola aliran yang tidak beraturan. 

 

 
Gambar 5.11 Pola Aliran Sungai Dengan Krib Permeabel 30 m 
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2. Impermeabel 

Hasil simulasi berupa distribusi kecepatan pada krib impermeabel dapat 

dilihat pada Gambar 5.12. 

 

 
Gambar 5.12 Distribusi Kecepatan Sungai Dengan Krib Impermeabel 30m 

 

Penggunaan krib sepanjang 30 m sepanjang 4 buah membuat kecepatan aliran 

pada dalam belokan sungai menjadi sekitar 0-0,74 m/s. Kecepatan aliran 

sebelum adanya krib pada daerah dalam belokan sungai berkisar antara 0-

0,18 m/s sehingga dengan adanya krib impermeabel 30 m terjadi peningkatan 

peningkatan kecepatan. Distribusi kecepatan pada daerah antar krib berkisar 

antara 0-0,18 m/s. 

Pola aliran sungai dengan krib impermeabel 30 m dapat dilihat pada Gambar 

5.13. Daerah dalam belokan sungai masih terjadi pusaran air dengan luas 

daerah yang lebih kecil daripada sebelum adanya krib. Pusaran air juga 

terbentuk di  daerah antar krib dengan arah melingkar. 
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Gambar 5.13 Pola Aliran Sungai Dengan Krib Impermeabel 30 m 

 

3. Perbandingan 

Daerah dalam belokan sungai pada krib permeabel dengan panjang 30 m 

memiliki distribusi kecepatan yang hampir sama dengan krib impermeabel. 

Distribusi kecepatan berkisar antara 0-0,74 m/s. Distribusi kecepatan pada 

daerah antar krib pada krib permeabel berkisar antara 0-0,74 m/s, sedangkan 

pada krib imperambel cenderung bernilai 0 m/s. 

Pola aliran pada dalam belokan di kedua jenis krib memiliki arah yang sama 

dengan luas pusaran air yang hampir sama. Pola aliran di daerah antar krib 

pada jenis krib permeabel lebih tidak beraturan daripada krib impermeabel. 

 

5.4.3 Simulasi Dengan Krib 40 m 

Simulasi dilakukan menggunakan krib dengan panjang 40 m sejumlah empat 

buah. Krib yang digunakan yaitu jenis krib permeabel dan impermeabel. Bentuk 

mesh yang akan dilakukan simulasi dapat dilihat pada Gambar 5.14. 
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Gambar 5. 14 Bentuk Mesh Dengan Krib 40 m Impermeabel (Atas) dan 

Permeabel (Bawah) 

 

1. Permeabel 

Hasil simulasi berupa distribusi kecepatan pada krib permeabel dapat 

dilihat pada Gambar 5.15. 

40 m 

40 m 
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Gambar 5. 15 Distribusi Kecepatan Sungai Dengan Krib Permeabel 40 m 

 

Kecepatan aliran sungai pada dalam belokan sungai memiliki perubahan 

yang cukup signifikan. Distribusi kecepatan aliran pada daerah dalam 

belokan berkisar antara 0,185-1,67 m/s. Daerah dalam belokan aliran tidak 

memiliki kecepatan pada nilai 0 m/s. Distribusi kecepatan pada daerah 

antar krib berkisar antara 0-0,74 m/s.  

 

 
Gambar 5.16 Pola Aliran Sungai Dengan Krib Permeabel 40 m 
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Pola aliran sungai dengan krib permeabel 40 m dapat dilihat pada Gambar 

5.16. Daerah dalam belokan aliran membentuk pusaran air dengan bagian 

yang lebih kecil daripada krib 30 m. Pola aliran pada daerah antar krib 

menjadi lebih tidak beraturan. 

 

2. Impermeabel 

Hasil simulasi berupa distribusi kecepatan pada krib impermeabel dapat 

dilihat pada Gambar 5.17. 

 

 
Gambar 5. 17 Distribusi Kecepatan Sungai Dengan Krib Impermeabel 40 m 

 

Daerah dalam belokan sungai memiliki kecepatan berkisar antara 0-1,67 

m/s. Daerah dalam belokan sungai masih memiliki aliran dengan 

kecepatan senilai 0 m/s tetapi dengan bagian yang lebih kecil daripada krib 

30 m. Distribusi kecepatan pada daerah antar krib yaitu 0 m/s. 
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Gambar 5. 18 Pola Aliran Sungai Dengan Krib Impermeabel 40 m 

 

Pola aliran sungai dengan krib impermeabel 40 m dapat dilihat pada 

Gambar 5.18. Pusaran air yang terjadi di dalam belokan sungai hanya 

terdapat pada awal masuk belokan sungai sedangkan pada daerah 

setelahnya pola aliran kembali normal searah aliran sungai. Pola aliran di 

daerah antar krib terjadi peningkatan pusaran air. 

 

3. Perbandingan 

Distribusi kecepatan di daerah dalam belokan sungai pada krib permeabel 

40 m memiliki nilai berkisar antara 0,185-1,67 m/s sedangkan pada krib 

impermeabel memiliki nilai berkisar antara 0-1,67 m/s. Krib 40 m dengan 

jenis permeabel memiliki nilai distribusi kecepatan yang lebih tinggi 

daripada jenis impermeabel. Daerah antar krib pada krib permeabel 

memiliki nilai distribusi kecepatan yang lebih tinggi daripada krib 

impermeabel. 

Pola aliran yang dihasilkan pada krib permeabel 40 m memiliki perbedaan 

dengan krib impermeabel. Perubahan dapat dilihat pada luas pusaran air 



46 
 

 
 

pada dalam belokan sungai, krib permeabel memiliki luasan lebih kecil 

dibandingkan krib impermeabel. Pola aliran di daerah antar krib pada krib 

jenis permeabel lebih tidak teratur daripada jenis impermeabel. 

 

5.4.4 Simulasi Dengan Krib 50 m 

Simulasi dilakukan menggunakan krib dengan panjang 50 m sejumlah empat 

buah. Krib yang digunakan yaitu jenis krib permeabel dan impermeabel. Bentuk 

mesh yang akan dilakukan simulasi dapat dilihat pada Gambar 5.19. 

 

 
Gambar 5.19 Bentuk Mesh Sungai Dengan Krib 50 m Impermeabel (Atas) 

dan Permeabel (Bawah) 

50 m 

50 m 
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1. Permeabel 

Hasil simulasi berupa distribusi kecepatan pada krib permeabel dapat 

dilihat dapat dilihat pada Gambar 5.20. 

 

 
Gambar 5.20 Distribusi Kecepatan Sungai Dengan Krib Permeabel 50 m 

 

Kecepatan aliran di daerah dalam belokan sungai memiliki nilai pada 

rentang 0,74-1,67 m/s. Daerah antar krib memiliki distribusi kecepatan 

berkisar antara 0-0,74 m/s. Kecepatan pada daerah antar krib pertama dan 

kedua dari hulu cenderung bernilai 0,74 m/s. 

Pola aliran sungai dengan krib permeabel 50 m dapat dilihat pada Gambar 

5.21. Pola aliran pada daerah dalam belokan sungai sudah tidak terjadi 

pusaran air dan mengarah mengikuti pola aliran sungai. Daerah antar krib 

memiliki pola aliran yang tidak beraturan terutama pada daerah hulu krib. 
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Gambar 5.21 Pola Aliran Sungai Dengan Krib Permeabel 50 m 

 

2. Impermeabel 

Hasil simulasi berupa distribusi kecepatan pada krib impermeabel dapat 

dilihat pada Gambar 5.22. 

 
Gambar 5.22 Distribusi Kecepatan Sungai Dengan Krib Impermeabel 50 m 

 

Peningkatan kecepatan terjadi pada daerah dalam belokan sungai. 

Kecepatan aliran pada dalam belokan sungai berkisar antara 0,74-1,67 m/s. 

Distribusi kecepatan pada daerah antar krib yaitu 0 m/s. 
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Gambar 5.23 Pola Aliran Sungai Dengan Krib Impermeabel 50 m 

 

Pola aliran sungai dengan krib impermeabel 50 m dapat dilihat pada 

Gambar 5.23. Pola aliran pada daerah dalam belokan sungai sudah tidak 

terjadi pusaran air dan mengarah mengikuti pola aliran sungai.  

 

3. Perbandingan 

Distribusi kecepatan pada krib 50 m permeabel di arah keluar belokan 

aliran memiliki distribusi kecepatan yang cenderung mengarah ke nilai 

0,74 m/s sedangkan pada tipe impermeabel cenderung mengarah ke nilai 

1,67 m/s. Distribusi kecepatan di daerah antar krib pada krib permeabel 

lebih tinggi daripada krib impermeabel. 

Pola aliran di daerah dalam belokan sungai pada jenis krib permeabel dan 

impermeabel adalah sama. Daerah antar krib pada krib permeabel 

memiliki pola aliran yang lebih tidak beraturan daripada krib 

impermeabel. 
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5.5 Pembahasan 

Adapun hasil rekapitulasi distribusi kecepatan pada belokan sungai melalui 

simulasi menggunakan aplikasi Telemac2D dapat dilihat pada Tabel 5.1. 

 
Tabel 5. 1 Rekapitulasi Hasil Distribusi Kecepatan 

Krib 

Jenis 

Dalam Belokan Luar Belokan/Antar Krib 

Permeabel Impermeabel Permeabel Impermeabel 

Tanpa Krib 0-0,185 m/s 0,74-1,67 m/s 

Krib 30 m 0-0,185 m/s 0-0,185 m/s 0-0,74 m/s 0-0,18 m/s 

Krib 40 m 0,185-1,67 m/s 0-1,67 m/s 0-0,74 m/s 0 m/s 

Krib 50 m 0,74-1,67 m/s 0,74-1,67 m/s 0-0,74 m/s 0 m/s 

 

Hasil simulasi menunjukkan bahwa peningkatan kecepatan di dalam belokan 

sungai terjadi pada semua jenis dan panjang krib tetapi masih ada bagian yang 

memiliki kecepatan 0 m/s pada krib permeabel dan impermeabel 30, serta krib 

impermeabel 40 m. Peningkatan kecepatan tertinggi yaitu pada krib permeabel dan 

impermeabel 50 m dari yang sebelumnya memiliki distribusi kecepatan 0-0,185 m/s 

menjadi 0,74-1,67 m/s. Sementara itu, pola aliran berbentuk pusaran air yang 

terbentuk sebelum adanya krib menjadi semakin kecil dengan adanya krib. Pola 

aliran sepenuhnya mengikuti arah aliran sungai utama dengan menggunakan krib 

50 m dengan jenis permeabel atau impermeabel. 

Distribusi kecepatan antar krib permeabel pada semua variasi panjang krib 

memiliki nilai 0-0,74 m/s dan pola aliran yang acak. Krib impermeabel memiliki 

distribusi kecepatan berkisar antara 0-0,18 m/s dengan pola aliran berbentuk 

pusaran air. Pusaran air tersebut memungkinkan terjadinya gerusan pada pinggir 

sungai (Przedwojski, 1995). 

Berdasarkan hasil simulasi yang dilakukan, krib pada belokan di hulu 

Bendung Klambu dapat dioptimalkan dengan menggunakan krib 50 m sehingga 

sudah tidak ada kecepatan aliran dengan nilai 0 m/s. Jenis krib impermeabel 
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memungkinkan terjadinya gerusan sungai karena terbentuknya pusaran air di antara 

krib sehingga jenis krib yang dipilih yaitu krib permeabel. 
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BAB VI 
KESIMPULAN DAN SARAN 

 
 
6.1 Kesimpulan 

Kesimpulan yang dapat diambil dari hasil analisis simulasi aliran pada sekitar 

krib di hulu Bendung Klambu sebagai berikut: 

1. Distribusi kecepatan di dalam belokan pada sungai tanpa krib yaitu 0-0,185 

m/s, sedangkan di luar belokan yaitu 0,74-1,67 m/s. 

2. Distribusi kecepatan dalam belokan sungai menggunakan krib permeable dan 

impermeable 30 m yaitu 0-0,18 m/s, sedangkan di daerah antar krib permeable 

30 m bernilai 0-0,74 m/s dan krib impermeable 30 m bernilai 0-0,18 m/s. 

3. Distribusi kecepatan dalam belokan sungai menggunakan krib permeable 40 m 

yaitu 0,185-1,67 m/s, krib impermeable 40 m yaitu 0-1,67 m/s, sedangkan di 

daerah antar krib permeable 40 m bernilai 0-0,74 m/s dan krib impermeable 40 

m bernilai 0 m/s. 

4. Distribusi kecepatan dalam belokan sungai menggunakan krib permeable 50 m 

yaitu 0,74-1,67 m/s, krib impermeable 50 m yaitu 0,74-1,67 m/s, sedangkan di 

daerah antar krib permeable 50 m bernilai 0-0,74 m/s dan krib impermeable 50 

m bernilai 0 m/s. 

5. Distribusi kecepatan di daerah dalam belokan sungai mengalami peningkatan 

pada semua jenis dan variasi krib yang disimulasikan. Peningkatan kecepatan 

tertinggi dengan menggunakan krib 50 m. 

6. Pola aliran pada daerah antar krib impermeabel membentuk pusaran air 

sedangkan daerah antar krib permeabel memiliki pola yang acak. 

7. Pola aliran di dalam belokan sungai menggunakan krib 30 m dan 40 m pada 

kedua jenis krib menghasilkan pola aliran berbentuk pusaran air. 

8. Pusaran air pada daerah dalam belokan menjadi pola aliran yang searah dengan 

aliran sungai dengan menggunakan krib permeabel atau impermeabel 

sepanjang 50 m. 
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6.2 Saran 

Adapun saran yang dapat disampaikan setelah melakukan penelitian simulasi 

aliran pada sekitar krib di hulu Bendung Klambu sebagai berikut: 

1. Untuk penelitian selanjutnya, simulasi aliran dapat dilakukan dengan 

menggunakan jenis, variasi, dan perletakkan krib yang berbeda. 

2. Hasil simulasi Telemac2D akan menghasilkan nilai dan bentuk yang lebih 

presisi dengan menggunakan mesh yang lebih rapat. 
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Lampiran 1 Prosedur Pembuatan Mesh Menggunakan Aplikasi BlueKenue 

 
Buka aplikasi lalu masukan file topografi sungai melalui File -> Open 
 

 
 

Pindahkan file topografi sungai ke 2D view dengan cara menarik file ke tab 2D 
View 
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Buat outline sungai menggunakan  fitur Closed Line yang dapat diakses 
melalui tombol pada gambar di bawah. Gambar outline sesuai dengan 
batas sungai.  
 

 
 

Buat batas kanan dan kiri sungai menggunakan fitur Open Lines yang 
dapat diakses melalui tombol pada gambar di bawah ini. 
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Buka fitur Channel Mesher pada File -> New -> T3 Channel Mesher.  
 

 
 

Tuliskan jumlah cross-channel nodes dan panjang mesh sepanjang 
sungai, lalu klik OK 
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Tarik open line kanan sungai ke sub-tab RightBank dan open line kiri 
sungai ke sub-tab LeftBank.  
 

 
 

Klik dua kali file T3 Channel Mesher dan pilih Run 
 

 
 

 



60 
 

 
 

Setelah di run, mesh akan berbentuk seperti gambar berikut. Untuk 
melihat tarik file mesh ke 2D View 
 

 
 
Buka T3 Mesh Generator melalui File -> New -> T3 Mesh Generator 
 

 
 

Tarik outline yang telah dibuat ke sub-tab Outline dan mesh sungai ke 
sub-tab SubMesh 
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Klik dua kali T3 Mesh Generator dan tentukan Default Edge Length 
and Edge Growth Ratio. Hapus centang pada Resample Outline lalu 
pilih OK. 
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Tarik New Mesh (NodeType) ke 2D View untuk melihat hasil mesh. 
 

 
 

Lakukan interpolasi menggunakan 2D Interpolator melalui File -> 
New -> 2D Interpolator. 
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Tarik file topografi ke tab newInterpolator2D.  
 

 
 

Klik pada mesh yang akan digunakan lalu Buka Tools -> Map Object, 
lalu klik newInterpolator2D. 
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Buat file selafin melalui File -> New -> SELAFIN Object 
 

 
 

Klik kanan file selafin lalu klik Add New Variable. Pilih mesh yang 
akan digunakan lalu pada menu Name, ganti pilihan dengan BOTTOM. 
Klik OK. 
 

 
Klik file BOTTOM lalu pilih Tools -> Map Object -> 
newInterpolator2D -> OK 
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Buat kondisi batas melalui File -> New -> Boundary Conditions -> 
BOTTOM -> OK 
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Tarik file BOTTOM_BC ke 2D View untuk membuat batas sungai. 
Batas sungai dibuat pada hulu dan hilir. Klik dua kali titik ujung kanan 
hulu sungai. Tekan Shift lalu klik dua kali titik ujung kiri hulu sungai. 
 

 
 

Klik kanan garis yang telah dibuat lalu Add Boundary Segment. Ganti 
Open Boundary Code menjadi Open boundary with prescribed Q. 
 

 
 

Lakukan hal yang sama pada daerah hilir sungai tetapi untuk Open 
Boundary Code diganti menjadi Open boundary with prescribed H. 
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Save file selafin, boundary conditions, dan tabel boundary 

 
 


